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RESUMEN

La Genética Forense es una disciplina que surgié con el fin de resolver casos criminales
utilizando informacion genética dejada en escenas del crimen. Sin embargo, también ha ofrecido
grandes ventajas en la identificacion humana a través de comparaciones directas y filiaciones a
través de familiares. Estas caracteristicas aportan a la identificacion de desaparecidos del Conflicto
Armado Interno (CAI), ocurrido entre los afios 1960 a 1996 en Guatemala. La busqueda y
recuperacion de estas victimas no ocurri6 sino hasta décadas después de que ocurrieran los hechos,
lo cual ha implicado trabajar con restos esqueletizados para lograr su identificacion a través del
ADN. Es frecuente obtener perfiles parciales o fallidos cuando se analizan los marcadores STRs de
ADN nuclear provenientes de restos antiguos. Debido a esta limitacion, la utilizacion de ADN
mitocondrial (ADNmt) para complementar los estudios, ya que se presenta en mayor numero de
copias en las células y se conserva por mas tiempo. La técnica de ADNmt mejorara los procesos
de la Fundacion de Antropologia Forense de Guatemala, cuya mision es la identificacion de los
desaparecidos del CAI. El objetivo del estudio es validar los kits BigDye™ Direct Cycle
Sequencing y BigDye™ XTerminator Purification en muestras humanas para la obtencion del
haplotipo de ADNmt. Se concluyé que el rango ideal de concentracion de ADN para la
secuenciacion y que es posible la obtencion del haplotipo de ADNmt a partir de hisopados bucales,
frotes bucales fijados en tarjeta FTA, sangre fijada en FTA, raiz de cabello, fragmentos dseos y

piezas dentales.



I. INTRODUCCION

La Genética Forense ha contribuido a la identificacion de victimas a través de la comparacion de los
perfiles genéticos de marcadores STR autosémicos (por las siglas en inglés de repeticiones cortas en
tandem) obtenidos a partir del ADN nuclear (ADNn) (Butler, 2010). Esta técnica se ve limitada ante
muestras con baja cuantificacion de ADN, degradacion y en caso de filiaciones cuando unicamente se
cuenta con familiares lejanos (Hares ef al., 2014; King et al., 2014). Para superar estas limitaciones al
trabajar con ADN ancestral, se ha recurrido a la genotipificacion del ADN mitocondrial (ADNmt) (Bandelt,
van Oven, & Salas, 2012; Hares et al., 2014).

El ADNmt presenta un numero de copias mas alto que el ADNn en las células humanas (Hares et al.,
2014). La mitocondria contiene entre 2 a 10 copias de ADNmt, y pueden haber hasta 1000 mitocondrias
por célula somatica (Budowle, Allard, Wilson, & Chakraborty, 2003). Por esta razon el analisis de ADNmt
es util en el area forense cuando no se logra obtener un perfil genético de STR autosoémicos satisfactorio

(Hares et al., 2014).

La baja fidelidad de la polimerasa de ADNmt y la aparente ausencia de mecanismos de reparacionn dan
lugar a una tasa de mutacion mas alta que la del ADNn (Budowle et al., 2003). El ADNmt posee regiones
polimorficas conocidas como Hipervariable I, II y III (HVI, HVII y HVIII, respectivamente) (Bandelt et
al., 2012). Las variaciones de secuencia entre individuos se encuentran especialmente en las regiones HVI
(16024-16365) y HVII (73-340) (Budowle et al., 2003; Hares et al., 2014). El reporte de haplotipos de
ADNmt para casos forenses o estudios poblacionales requiere identificar solamente las diferencias con
respecto a la version revisada (rCRS, NC001807) de la primera secuencia de ADNmt humano (Hares et al.,
2014). Segun este requisito, se tiene por objetivo validar un procedimiento operacional estandar que
permita la correcta secuenciacion y genotipificacion de las regiones HVI y HVII del ADNmt de muestras
forenses y reportar los haplotipos obtenidos seglin las recomendaciones de SWGDAM (Scientific Working
Group on DNA Analysis Methods) (Scientific Working Group on DNA Analysis Methods, 2016).

Es posible la genotipificacion de ADNmt utilizando los kits BigDye™ Direct Cycle Sequencing
(Applied Biosystems™, CA, EE. UU.) y Big Dye™ XTerminator Purification (Applied Biosystems™,
CA, EE. UU.) en muestras referenciales y esqueléticas con fines de identificacion humana para las
aplicaciones del Laboratorio de Genética Forense de la Fundacion de Antropologia Forense de Guatemala.
El método cuanta con la informacién necesaria para amplificar, secuenciar y analizar los resultados para

reportar haplotipos de ADNmt.



II. OBJETIVO

A. OBJETIVO GENERAL

Validar los kits BigDye™ Direct Cycle Sequencing (Applied Biosystems™, CA, EE. UU.) y
BigDye™ XTerminator Purification (Applied Biosystems™, CA, EE. UU.) para la secuenciacion
y obtencion de haplotipos del ADNmt en muestras humanas (hisopado bucal, frote bucal fijado en
tarjeta FTA, sangre fijada en FTA, raiz de cabello, fragmentos 6seos y piezas dentales), para el
estudio poblacional de los grupos etnolingiiisticos achi, ixil, kaqchikel, ladino, queqchi y quiché en

Guatemala a partir de 102 muestras referenciales.
B. OBJETIVOS ESPECIFICOS

Evaluar la exactitud y precision de la técnica propuesta para la genotipificacion de ADN
mitocondrial (ADNmt), utilizando los kits BigDye™ Direct Cycle Sequencing (Applied
Biosystems™, CA, EE. UU.) y BigDye™ XTerminator Purification (Applied Biosystems™, CA,
EE. UU.), realizando una comparacion intralaboratorio al reanalizar una muestra previamente

caracterizada por un laboratorio externo al de la Fundacion de Antropologia Forense de Guatemala.

Determinar el rango de concentracion 6ptimo de ADN que asegure la genotipificacion del

ADNmt a través del estudio de sensibilidad.

Realizar el estudio de estabilidad de la técnica para la obtencion de un haplotipo de ADNmt al

procesar muestras de hisopado bucal colectadas desde el afio 2009 hasta el afio 2018.

Evaluar la repetitividad de la técnica, procesando diversos sustratos (hisopado bucal fijado en
tarjeta FTA, sangre fijada en tarjeta FTA y raiz de cabello) colectados del mismo donante y

comparando el haplotipo obtenido de cada uno de ellos.

Comprobar la reproducibilidad de la técnica de genotipificacion al obtener el haplotipo de las

mismas muestras por dos operadores diferentes en tiempos diferentes.
Determinar como se veria una muestra con mas de un donante de ADNmt (mezcla).

Genotipificar el ADNmt de los grupos etnolingiiisticos achi, ixil, kaqchikel, ladino, queqchi y

quiché (n=17 por grupo) para el estudio poblacional guatemalteco.



I1I. JUSTIFICACION

Las investigaciones en la Fundacion de Antropologia Forense de Guatemala (FAFG) consisten
en la identificacion de victimas del Conflicto Armado Interno (CAI). La FAFG contribuye al
fortalecimiento del sistema de justicia y los derechos humanos ya que provee de evidencia que

puede ser utilizada ante un proceso legal o solicitada por el Ministerio Publico.

La Genética Forense contribuye a la identificacion de victimas a través de la comparacion de
los perfiles genéticos de marcadores STRs autosomicos obtenidos a partir del ADN nuclear
(ADNn) de un indicio indubitado (se conoce al donante del ADN) y un indicio dubitado (se
desconoce la identidad del donante del ADN) En el contexto del trabajo de la FAFG, las muestras
indubitadas provienen de familiares que contintian en la biisqueda de sus desaparecidos y que donan
una muestra genética, comunmente llamadas muestras referenciales. Los indicios dubitados son los
restos 6seos de las victimas que son recuperados de fosas clandestinas, cementerios, etc. que en su
mayoria datan de la década de los afios 1980. Los diferentes contextos y tiempos de deposicion de
los restos esqueletizados provocan la degradacion del ADNn lo que dificulta la obtencion de un
perfil genético de STRs autosomicos completo que pueda ser comparado con los obtenidos de los
grupos familiares. Un segundo reto en la investigacion son las filiaciones complejas, aquellos casos
en los que no se cuenta con muestras de familiares cercanos (por ejemplo, del nucleo familiar) sino
de familiares en segundo o tercer grado (por ejemplo, tios abuelos). En ambos casos, contar con
una herramienta genética que pueda complementar la informacidon generada al analizar STRs
autosdmicos aumentaria las probabilidades de generar una coincidencia genética y por lo tanto la

identificacion de una osamenta.

Cabe mencionar que, la genotipificacion del ADNmt no es individualizante ya que es heredado
sin eventos de recombinacion entre madres e hijos. En comparacion, la genotipificacion del ADNn
si logra la individualizacion ya que cada perfil genético de STRs nucleares es tinico y diferente para
cada individuo, con la excepcion de gemelos idénticos. Sin embargo, el compartir el mismo
haplotipo entre diferentes generaciones dentro del mismo linaje materno permite la filiacion atn
con familiares distantes dentro de este linaje. De tal forma, que la genotipificacion del ADNmt en
muestras comprometidas (baja concentracion de ADN, degradacion, etc.) ofrece varias ventajas,
como: mejor conservacion en herencia vertical, mayor numero de copias del genoma mitocondrial
por célula y sufrir menor degradacion por ser un genoma circular y de menor tamafio. La
integracion de esta técnica forense permitiria mejorar los procedimientos de identificacion humana

a través de la Genética Forense en el trabajo de la FAFG.



Adicionalmente, para poder incluir el peso estadistico de coincidencias genéticas utilizando el
haplotipo de ADNmt, es necesario llevar a cabo un estudio poblacional para conocer la distribucion
de los haplotipos presentes en la poblacion guatemalteca. Debido a que Guatemala cuenta con
varios grupos etnolingiiisticos, es necesario considerarlos y establecer los haplogrupos presentes,
estableciendo la frecuencia de cada uno de ellos. Debido a la alta conservacion de del ADNmt se
busca maximizar el tamafio de muestra (n=17) por grupo etnolingiiistico, con la limitacion de un
maximo de 102 muestras. Se seleccionaron los grupos achi, ixil, kaqchikel, ladino, queqchi y quiché
para el estudio poblacional debido a la alta disponibilidad de muestras (almacenadas desde el 2009
hasta el 2018) y su utilidad para fines de identificacion ya que provienen de familiares de victimas

de desaparicion.



IV. MARCO TEORICO

A. ACIDO DESOXIRRIBONUCLEICO

Los acidos nucleicos, incluido el ADN, se constituye por nucleoétidos los cuales constan de una
base (variante), una azucar y un fosfato (que constituyen la cadena estructural). Los nucleétidos,
también conocidos como bases nitrogenadas o solamente bases, son la adenina (A), tiamina (T),
citosina (C) y guanina (G) (Butler & Butler, 2010). El azcar que contiene el ADN es desoxirribosa
lo que explica el nombre de “Desoxirribonucleico” (Krebs, Goldstein, & Kilpatrick, 2014). El
genoma humano esta constituido por ADN contenido en el nucleo (ADNn) y en las mitocondrias.
El ADN mitocondrial (ADNmt) contribuye con un 0.0006% al genoma humano total (Mark
Stoneking, 1994). En el Cuadro 1 se muestran algunos datos sobre la cantidad de ADN contenido

en muestra bioldgica.

Cuadro 1. Contenido de ADN en muestras biologicas.

Tipo de muestra Cantidad de ADN
Sangre liquida 20,000 — 40,000 ng/mL
Mancha de sangre 250 -500 ng/cm’
Semen liquido 150,000 — 300,000 ng/mL
Hisopado vaginal poscoital 10 — 3,000 ng/hisopo
Cabello con raiz arrancado 1 -750 ng/raiz
Cabello con raiz rasurado 1 — 10 ng/raiz
Saliva liquida 1,000 — 10,000 ng/mL
Hisopado bucal 100 — 1,500 ng/hisopo
Orina 1 —20 ng/mL
Hueso 3 - 10 ng/mg
Tejido 50 — 500 ng/mg
Las muestras de evidencia son significativamente afectadas por factores en el ambiente (Lee &
Ladd, 2001).

La contribucion genética en la descendencia proviene de 22 cromosomas autosémicos, un
cromosoma X y el ADNmt en el 6vulo de la madre; 22 cromosomas autosémicos y un cromosoma
X 0 Y en el espermatozoide (Figura 1) (Butler & Butler, 2010). Debido a que el ADNmt no sufre
recombinacion es posible trazar la descendencia materna entre generaciones bastante separadas
(Budowle et al., 2003). El espermatozoide posee mitocondrias en la region del cuello y la cola,
pero son destruidas durante o poco después de la fertilizacion (Budowle et al., 2003). Las
mitocondrias espermaticas desaparecen en etapas tempranas de la embriogénesis (Amorim,
Fernandes, & Taveira, 2019), por destruccion selectiva, inactivacion o dilucion . Recientemente se
describio inherencia biparental de ADNmt entre 17 miembros de tres familiares con multiples

generaciones, los resultados fueron confirmados por dos laboratorios externos (Luo et al., 2018).
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Figura 1. Material genético en los gametocitos y cigoto.
Fuente: (Butler & Butler, 2010).

El 6vulo contribuye con 22 cromosomas autosémicos, un cromosoma sexual y ADN
mitocondrial. El espermatozoide contribuye con 22 cromosomas autosdémicos y un cromosoma
sexual. LA formacion del cigoto posee 22 pares de cromosomas autosomicos, dos cromosomas

sexuales y ADN mitocondrial.
B. GENOTIPIFICACION DE ADNmt

El analisis de ADNmt se utiliza en casos forenses cuando los marcadores nucleares no pueden
ser aplicados. El uso de haplogrupos, seglin las regiones variables, sugieren un control adicional
del codigo regional, lo cual incrementa el poder de discriminacion del ADNmt (Bandelt et al.,
2012). Debido a la inherencia materna del ADNmt solamente algunas muestra de comparacion son

utiles segiin se muestra en la siguiente figura.
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Las muestras utiles para la comparacion genética de ADNmt se muestran en color café y esta
relacionado con el linaje materno heredado a toda su descendencia, pero solamente transmitido
por mujeres. Lo que permite la trazabilidad del ADNmt entre la familia, incluso, entre parientes

lejanos o comparaciones complejas.

El ADNmt presenta un nimero de copias mas alto que el ADNn en células humanas (Hares e?
al., 2014). La mitocondria contiene entre 2 a 10 copias de ADNmt, y pueden haber hasta 1000
mitocondrias por célula somatica (Budowle et al., 2003). Por esta razon el analisis de ADNmt es
util en el area forense cuando no se logra obtener un perfil genético de STRs autosdémicos

satisfactorio (Hares et al., 2014).

La baja fidelidad de la polimerasa de ADNmt y la aparente ausencia de mecanismos de
reparacion dan lugar una tasa de mutacion mas alta que la del ADNn (Budowle ef a/., 2003). Se ha
reportado la estimacion de la tasa de mutacion en las dos regiones hipervariables en 0.32 x 10/
sitio / afio (IC 95% 0.065 x 10 —0.97 x 10®) lo cual es mayor en comparacion a 0.5 x 107/ sitio
/ afio en genoma nuclear (Amorim et al., 2019). El ADNmt posee regiones polimorficas conocidas
como Hipervariable I, II y III (HVI, HVII y HVIII respectivamente) (Bandelt et al., 2012). Las
variaciones de secuencia entre individuos se encuetran especialmente en las regiones HVI (16024-

16365) y HVII (73-340) (Budowle et al., 2003; Hares et al., 2014).



Para el reporte de haplotipos de ADNmt para casos forenses o estudios poblacionales requiere
identificar solamente las diferencias con respecto a la version revisada (rCRS, NC001807) de la

primera secuencia de ADNmt humano (Hares et al., 2014).

Estudios por Sochtig ef al. (2015) evaluan la variabilidad genética de los grupos maya y ladinos
de Guatemala (Figura 3) a través de marcadores uniparentales y ancestrales. En este estudio llegan
a concluir que las caracteristicas filogenéticas del ADNmt son compatibles con la endogamia
moderada local, el aislamiento de los mayas combinado con episodios de intercambio de genes

dentro los grupos étnicos.
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Alta Verapaz
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Honduras
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Figura 3. Mapa de la Republica de Guatemala con las areas de muestreo.
Fuente: (Sochtig et al., 2015)

El mapa recalca las areas de muestreo que abarcan Alta y Baja Verapaz, El quiché y la
ciudad Capital. Las muestras provenian de los siguientes grupos etnolingiiisticos: qeqchi, achi,

pogomchi, quiché y kaqchikel.
C. ADN ANCESTRAL

Debido a las ventajas del ADNmt mencionadas anteriormente ante el ADNn se han logrado
realizar estudios antropologicos tales como los hecho en México sobre la demografia historica de
la poblacion indigena (Rubi-Castellanos et al., 2015) o la identificacion de los restos del rey
Ricardo III (King ef al., 2014). Aunque existen algunos desafios al momento de trabajar con ADN

ancestral, debido a las modificaciones que ocurren después de la muerte como: el rompimiento de



una hebra de ADN, modificacion de una base por oxidacion e hidrélisis y pérdida de bases
(Cipollaro, Galderisi, & Di Bernardo, 2005). La degradacion del ADN esta relacionada a las
condiciones ambientales, sobre todo la temperatura de deposicion y no tanto sobre su edad

arqueologica o tiempo de deposicion (Allentoft et al., 2012).

También existen desafios externos a la integridad del ADN, tales como la presencia de
inhibidores que intervienen en los procesos de amplificacion y secuenciacion de las muestras,
generando resultados pobres y de baja calidad (Alaeddini, 2012). Algunos de estos inhibidores son
los acidos humicos y fulvicos, residuos de parafirina o sus productos de degradacion (Montiel,

Malgosa, & Subira, 1997; Pidibo, 1989).

Debido a la especificidad de los kits la contaminacion por parte de bacterias, virus, animales y
hongos no compiten en las reacciones para generar perfiles genéticos, pero si compite con la de
otro donador. Como tultimo desafio se debe resaltar la contaminacion de ADN humano exdgeno.
Esta contaminacion pudo haber ocurrido durante la muerte, en los rituales de sepultura, durante la

exhumacion y su analisis antropoldgico (Anastasiou & Mitchell, 2013).
D. TOMA DE MUESTRA

El hisopado bucal es un método no invasivo de recoleccion de tejido que consiste en transferir
células epiteliales por frotacion a un hisopo. La toma de muestra con esta técnica tiene las siguientes
ventajas: representa un menor riesgo bildgico tanto para el donante como para quien toma la
muestra, no existe problema de derrame de material bildgico y se puede almacenar a temperatura
ambiente (Jehuda, 1993). En la FAFG se utiliza este método de recoleccion de muestras y

adicionalmente se fijan en tarjetas FTA.

Las tarjeas FTA (Flinders Technology Associates) constan de un papel filtro recubierto con
algunos agentes quimicos que permiten la fijacion y preservacion de muestras de ADN (Patent No.
5,496,562, 1996; Green, Tillmar, Pettersson, & Montelius, 2019). Existen métodos de extraccion
de ADN para las tarjetas FTA, pero han salido al mercado kits que utilizan pequefos fragmentos
de la tarjeta directamente en la reaccion de PCR, lo cual es una ventaja costo efectiva en
comparacion a otras técnicas de toma de muestra (Mundorff ez al., 2018). Se reportd que es posible
obtener perfiles de STR completos a partir de muestras almacenadas por 16 afios en tarjetas FTA,
aunque detectaron que la cantidad y degradacion del ADN decrece con relacion al tiempo de

almacenamiento (Rahikainen, Palo, de Leeuw, Budowle, & Sajantila, 2016).



E. SECUENCIACION

En 1975 Frederick Sanger desarrollé un método para determinar la secuencia de nucledtidos de
ADN, y el método fue nombrado Secuenciacion Sanger. El procedimiento consiste en preparar
cuatro reacciones en las que se incluian trifosfatos de desoxinucléicos (INTP) normales A, G, Cy
T, pero cada uno contiene un nivel bajo de uno de los cuatro trifosfatos de didesoxinocledtidos
(ddNTP). Al incorporarse uno de los ddNTP en la sintesis de la cadena de ADN termina. Los
productos de cada reaccion se separan por electroforesis en gel; cuya lectura se realiza de abajo

hacia arriba segun aparezcan las bandas en cada carril (Sanger, Nicklen, & Coulson, 1977).

Algunos de los eventos estructurales del ADN son las sustituciones, deleciones o inserciones de
bases (Arsham & Shaffer, 2017). Estos eventos son detectados al comparar la secuencia de las
muestras con una Secuencia de Referencia, que se genera a partir de un consenso (Scientific
Working Group on DNA Analysis Methods, 2019). Las sustituciones consisten en los cambios de
bases; las deleciones, en la perdida de las bases; las inserciones, en la adquisicion de bases

inexistentes en la referencia (Arsham & Shaffer, 2017; Butler & Butler, 2010).

F. VALIDACION DE METODO

La FAFG se rige bajo la norma ISO 17025, la cual exige la validacion de todos sus métodos.
Estas validaciones implican realizar pruebas con los equipos, reactivos, operadores y muestras que
permitan garantizar resultados confiables (ISO, 2017). Por lo que se utilizara la guia para la
validacion de métodos de analisis de ADN que contempla los siguientes estudios: La exactitud que
se evalia consta en analizar la habilidad de la técnica (reactivos e instrumentos) para proveer
resultados (secuencias del ADNmt) cercanas a la secuencia conocida (previamente obtenida por un
laboratorio Forense acreditado y externo al de la FAFG). El estudio de sensibilidad busca establecer
los rangos dinamicos e ideales de concentraciones de ADN para la obtenciéon de la secuencia
completa del ADNmt necesarios para reportar el haplotipo de forma correcta a partir de muestras
referenciales y esqueléticas. La repetitividad consta de la evaluacion de la exactitud y precision de
los resultados obtenidos por un mismo operador y/o equipo, para el cual se espera obtener los
mismos resultados para una muestra procesada varias veces. El estudio de reproducibilidad busca
evaluar la exactitud y precision para obtener los mismos resultados para dos operadores y/o equipos
diferentes. La evaluacion de mezclas como parte de la validacion permite reconocer resultados de
mezclas o muestras contaminadas. El programa de analisis también debe ser validado para

completar el proceso, por lo que se requiere de compararlo con los resultados de otro programa
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previamente validado o con resultados provistos por otro laboratorio validado (Scientific Working

Group on DNA Analysis Methods, 2016).

El programa de analisis para este estudio es Sequencher® (GeneCodes), que permite ensamblar
y alinear secuencias, detectar polimorfismos de un solo nucleétido (SNP por sus siglas en inglés).
Entre sus funciones estd la generacion de haplotipos de ADNmt bajo estandares forenses, pero
posee otras herramientas de andlisis de secuenciaciéon de Sanger o de secuenciacion en paralelo o

nueva generacion (Gene Codes Corporation, 2018).

El estudio poblacional consiste en la parte final de la validacion, en la que se caracteriza a un
grupo de interés, que en el caso de ADNmt consiste en la identificacion de los haplogrupos de la

poblacion (conjunto de eventos estructurales propios del grupo) (Budowle et al., 2003).

1. Genotipificacion de ADNmt
Se realizaron 5 recomendaciones por parte de la Sociedad internacional para la Genética Forense

(Hares et al., 2014):

» Se debe trabajar bajo buenas practicas de laboratorio y protocolos especificos para trabajar
ADNmt.

« Entodo el proceso deben considerarse los controles negativos, positivos y blancos requeridos.

» Se deben reportar solamente las secuencias consenso basado en la informacion redundante de
la secuencia al utilizar secuencias directas e indirectas.

o Debe evitarse la transcripcion manual de datos y reportar haplotipo conceso por parte de dos
operadores.

» Los laboratorios que tipifiquen ADNmt para casos forenses deben participar regularmente en

pruebas de aptitud.

2. Lineamientos para la interpretacion del analisis de ADNmt

Son necesarios el uso y evaluacion de controles, el obtener los resultados esperados garantiza
cumplir con estandares de calidad. Deben cubrirse la region hipervariable I (HVI, en las posiciones
16024 a 16365) y la region hipervariable I (HVII, en las posiciones 73 a 340). El llamado de bases
o designacion de bases deben ser segun el sistema de nomenclatura IUPAC (International Union
of Pure and Applied Chemistry) incluso para las ambigiiedades. (Scientific Working Group on
DNA Analysis Methods, 2019). La presentacion de haplotipos debe cumplir con las reglas
SWGDAM (existen otros dos reglamentos):

Regla 1: Mantener los patrones conocidos de polimorfismos.
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Regla 2: Usar todas las diferencias requeridas, al menos que viole los patrones conocidos de

polimorfismos.

Regla 3: Los estiramientos en C en HVI deben interpretarse con un 16189C cuando el T anclado
en la posicion 16189 no esta presente. Las variaciones de longitud en el tracto A corto que precede
a 16184 deben notarse como transversiones. Los estiramientos en C en HVII deben interpretarse
conun 310C cuando la T anclada en la posicion 310 no esta presente. Los estiramientos en C deben

interpretarse con un 311T cuando la T anclada en la posicion 310 es seguida por una segunda T.
La regla 4 serd omitida debido a que aplica para la region HVIII.
Regla 5: Se prefieren sustituciones ante inserciones y deleciones.
Regla 6: Se prefieren transiciones a transversiones.
Regla 7: Colocar inserciones y deleciones continuamente cuando sea posible.
Regla 8: Colocar inserciones y deleciones en el extremo 3’ de la hebra ligera.

La regla 9 serd omitida debido a que no aplica para las regiones hipervariables I y II.
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V.METODOLOGIA

A. SITIO DE ESTUDIO

No se puede delimitar un sitio especifico debido a la heterogeneidad de las muestras, sin

embargo, todas provienen del territorio guatemalteco.
B. SUJETOS DE ESTUDIO

Individuos en busqueda de sus familiares desaparecidos.
Individuos de los cuales se logré recuperar la osamenta o parte de ella.
Colaboradores de la Fundacion de Antropologia Forense de Guatemala.

Individuos pertenecientes a las comunidades achi, ixil, kaqchikel, ladino, queqchi y quiché en

Guatemala.
C. DISENO, ENFOQUE Y TIPO DE INVESTIGACION

El disefio experimental de tipo verdadero es el apropiado para este estudio ya que se busca
evaluar variables para determinar el rango de concentracion de ADN en el cual es posible obtener
un haplotipo, siempre acompaiado de controles positivos y negativos que permitan validar y
proporcionar confiabilidad en las pruebas. También consta de un disefio no experimental de tipo
transversal en la que se caracterizara las diferencias entre los haplogrupos de algunas comunidades
guatemaltecas; y de tipo longitudinales en la que se evaluara la estabilidad de muestras tomadas

entre los afos 2009 al 2018 y muestras del mismo individuo tomadas en distintos afios.

Este estudio consta de un enfoque mixto en el cual la fase cualitativa abarca la validacion de un
método para la generacion de haplotipos de ADNmt, en lo que se evaluara sensibilidad, precision,
exactitud, repetitividad, reproducibilidad, estabilidad y mezclas. En la fase cualitativa se busca
caracterizar a las comunidades achi, ixil, kaqchikel, ladino, queqchi y quiché a través de la
evaluacion de frecuencias en cabios presentes en las diferentes posiciones de las regiones HVI y

HVIIL

D. TIPO Y TAMANO DE MUESTRA

El estudio requiere de extractos de muestras Oseas, muestras referenciales que incluyen:

hisopados bucales, muestras de sangre y bucales fijadas en FTA y cabellos con raiz.

El estudio poblacional requiere de 17 muestras por comunidad, para un total de 102 muestras.
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Tamafio de muestra y tipo de muestreo es con fines especiales para los estudios de sensibilidad,

precision, exactitud, repetitividad, reproducibilidad, estabilidad y mezclas; y un muestreo por
conveniencia para el de poblacion.

E. CRITERIOS DE INCLUSION Y EXCLUSION

Cuadro 2. Criterios de inclusion y exclusion.
Estudio Inclusién
Sensibilidad

Exclusion
1 muestra con un extracto de concentracion Muestras no cuantificadas
minima de 1.50 ng/pL. (exceptuando en caso de
Muestras bucales o de sangre fijadas en perforacion de FTA).
tarjetas FTA.
Muestras con haplotipo de ADNmt
conocido (muestra de referencia, evaluado
por un laboratorio acreditado externo a la
FAFQG).

Criterios

Extractos de muestras 6seas cercanas a las
siguientes concentraciones 0.298, 0.130,
0.050, 0.025, 0.013 y 0.002 ng/uL con perfil
de STRs autosomicos.
Un extracto de muestra 6sea con
cuantificacion mayor a 4.0 ng/pL.
Estabilidad Muestras de hisopados bucales tomadas en
los afios 2009, 2011, 2014, 2017 y 2018,
Precision Diferentes diluciones de ADN para una
misma muestra.

Muestras que se desconoce el
afo de toma de muestra.
Muestras con cuantificacion
inferior a 1.50 ng/pL.
Muestra de donante diferente.
Muestras tomadas en el
laboratorio.
Muestras sin respaldo de
haplotipos generados en otros
laboratorios.
Muestras evaluadas por
diferentes analistas.
Muestras procesadas por el
mismo analista.
Los donadores pertenecen al
mismo linaje materno.

Exactitud 2 muestras de haplotipo de ADNmt
conocido.
Haplotipo que abarca la region HVI y HVIL.
Muestras bucales o sangre fijadas en tarjeta
FTA.
Repetibilidad' Muestra bucal y de sangre fijada en tarjeta
FTA y cabello con raiz del mismo donante.
Reproducibilidad>  Muestras previamente evaluadas por otro
analista.
Mezcla Se conoce la conformacion de la muestra
(quienes son los donadores).
Se gener6 o conoce los haplotipos de los
donadores.
Poblacional Pertenecer a uno de los siguientes grupos
etnolingiiisticos: Achi, Ixil, Kaqchikel,
Ladino, Queqchi y Quiché.
Disponibilidad de extractos de ADN.

Muestras de individuos
pertenecientes al mismo linaje
materno (corroborado con los

genogramas).

! Evaluacion de la precision y exactitud en la obtencién de resultados por un mismo operador.
? Evaluacion de la precision y exactitud en la obtencion de un resultado por varios operadores.
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F. VARIABLES

Cuadro 3. Variables.

Variable Descripcion general Naturaleza Nivelde  Codificacion/unidad de
medicion medicion
Haplotipo Serie de posicionesy ~ Cualitativo  Nominal Si (se generd un
bases que difieren haplotipo)
entre la secuencia de No (no se pudo generar
ADNmt de la muestra un haplotipo)
con la rCRS?,
Tipo de Tejido y/o sustrato que  Cualitativo  Nominal Oseo (evidencia)
muestra contiene el material Hisopado bucal
genético de interés. (referencial)
Bucal fijado en tarjeta
FTA (referencial)
Sangre fijada en tarjeta
FTA (referencial)
Raiz de cabello
(referencial)
Afio Afo en el que la Cuantitativo Discreta  Afio de toma de muestra.
muestra fue tomada.
Poblacion Muestras de referencia  Cualitativo ~ Nominal Achi
provenientes de una Ixil
comunidad Kaqchikel
guatemalteca Ladino
Queqchi
Quiché
Concentracion Cantidad de ADN Cuantitativo Continua ng/ul
suspendido en
determinado volumen.
Analista Investigador que Cualitativo ~ Nominal Analista 1
procesa la muestra Analista 2

dese PCR hasta el
reporte del Haplotipo.

G. INSTRUMENTOS DE MEDICION

No se utilizo ningun instrumento para la coleccion de datos.

3 Revised Cambridge Reference Sequence.
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H. METODOLOGIA
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Figura 4. Procedimiento para procesamiento de muestras con ADNmt.

16



1. Extraccion de ADN

Se utilizo la extraccion de ADN por Chelex para hisopados bucales. El proceso emplea la resina
Chelex 100® (Laboratorios Bio-rad, CA, EE. UU.) al 5%, altamente purificado aplicando el
procedimiento operacional estandar (POE) DNA0011%,

Se utilizo la extraccion de ADN de muestras de raiz de cabello, material manchado con sangre
o saliva aplicando el procedimiento D del POE DNA0010°. Este procedimiento, hace uso del kit
QIAamp® DNA Micro (QIAGEN, CA, EE. UU.) disenado para purificacion de ADN total para
varios sustratos y muestras de volumen o tamafio reducido. Se llevo a cabo la purificacion de ADN
de muestras de células bucales o sangre fijadas en FTA siguiendo el procedimiento G del POE
DNAO0010 que utiliza “reactivo de purificacion de FTA” (GE, NJ, EE. UU.) y solucion

amortiguadora TE.
2. Cuantificacion de ADN

Se utiliz6 el kit Quantifiler™ Trio DNA Quantification (Applied Biosystems™CA, EE. UU.)
con el sistema 7500 Fast & 7500 Real-Time PCR System (Applied Biosystems™, CA, EE. UU.)
para la cuantificacion de ADN total humano presente en extractos segin POE DNA0022°.

3. Reaccion en cadena de la Polimerasa
Se amplifico las regiones HV1 y HV2 para todos los sustratos de ADN utilizando el kit
BigDye™ Direct Cycle Sequencing (Applied Biosystems™, CA, EE. UU.) y los cebadores F15978,
R16391, F30 y R408 segin el POE DNA0070 (Anexo A).

4. Gel de electroforesis
Los productos de PCR se evaluaron a través de electroforesis en gel de agarosa empleando el
sistema E-Gel® iBase™ (Invitrogen™, CA, EE. UU.) que emplea luz ultravioleta para la

visualizacion de bandas segiin el POE DNA0070.

5. Secuenciacion

Los productos de PCR se procesaron con el kit BigDye™ Direct Cycle Sequencing (Applied
Biosystems™, CA, EE. UU.) y BigDye™ XTerminator Purification (Applied Biosystems™, CA,
EE. UU.), segin el POE DNA0070 para la obtencion de la secuencia de ADN mitocondrial de las

*DNA0011_B_Insolation of DNA by Chelex SOP, método validado en la FAFG.
>DNA0010_D Isolation of DNA from Various Substrates, método validado en la FAFG.
® DNA0022 D Quant Trio_SOP, método validado en la FAFG.
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regiones HVI y HVII a través de la técnica de Secuenciacion de Sanger con el Analizador Genético

3500 (Applied Biosystems™, CA, EE. UU.).

6. Determinacion de haplotipos
Los resultados de la secuenciacion se analizaron con el programa Sequencher® (GeneCodes,

MI, EE.UU.) segin el POE DNA0071 (Anexo B).

7. Estudio poblacional
El ntimero de haplotipos fue calculado por el método de conteo directo. La capacidad de
discriminacion fue estimada al dividir el nimero de haplotipos diferentes por el total de individuos
(Rakha et al., 2017). Se estimé la diversidad de Haplotipos (DH), DH =n(1—Y f%)/(n— 1),
donde f'es la frecuencia de la muestra de cada haplotipo y z es el nimero de individuos (Chen et
al.,2015). La probabilidad de coincidencia aleatoria (PCA) es PCA = Y, f2, donde frepresenta la
frecuencia de cada haplotipo de ADNmt (M. Stoneking, Hedgecock, Higuchi, Vigilant, & Erlich,
1991). Se estim6 el rendimiento como (R) = N/H, donde N corresponde al numero total de
individuos evaluados y H la cantidad de individuos que se logroé genotipificar. Los resultados de

los calculos se multiplicaron por 100 para poder reportar los resultados como porcentajes.
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VI. RESULTADOS

A. EXACTITUD

Hubo un 100% de coincidencia entre el haplotipo esperado (Cuadro 4) y obtenido utilizando la

técnica propuesta en este proyecto de investigacion (Cuadro 5) para las muestras M2 y M3.

Cuadro 4. Haplotipos generados en laboratorio externo para la muestra M2 y M3.

HVI HVII

ITEM N n % (16024-16365) N n % (73-340)

Ml 53 52 98 TI16224CTI16311C 50 48 96 A73G Cl14T A263G -315.1C
M2 53 53 100 Sin diferencias 51 50 98 A73G CI50T A263G -315.1

M3 53 51 96 GI6213A A16293G 52 50 96 A263G-315.1C
N = numero de laboratorios que han realizado el andlisis. n = nimero de laboratorios con

consenso. Los haplotipos (gonotipos de ADNmt) en genética forense se reportan con la
nomenclatura UPAC y los lineamientos de SWGDAM. Los haplotipos muestran las diferencias
entre la referencia y la muestra, la posicion se indica con ntimeros, seguidos por la base (A, T, C
0 Q) en caso de que la diferencia sea una sustitucion. La posicion seguido de “-* para las
deleciones. La posicion seguido de “. #” (el # es un nimero correlativo de inserciones)

acompaiiados por la base insertada.

Cuadro 5. Haplotipo generado en la FAFG para la muestra M2 y M3.

Muestra HVI (16024-16365) HVII (73-340)
M2 Sin diferencias 73G 150T 263G 315.1C
M3 16,213A 16,293G 263G 315.1C

No se muestran resultados para la muestra M1 debido a que el extracto de ADN se perdio por

evaporacion.

B. PRECISION

Se obtuvo el mismo haplotipo (f = 100%, N = 16) para la muestra M2 en diferentes
procesamientos al trabajar con concentraciones de 1.780, 1.000, 0.500, 0.250, 0.125, 0.060, 0.030,
0.015 ng/uL (en duplicado). Estos resultados también se utilizaron para evaluar la sensibilidad del

método (rango ideal).

C. SENSIBILIDAD

Se evalu6 la sensibilidad para muestras extraidas por el método Chelex (hisopado bucal) y
QIAamp (hisopado bucal fijado en tarjeta FTA, sangre fijada en tarjeta FTA y raiz de cabello), los
métodos de rutina para muestras referenciales en las instalaciones de la FAFG. En los Cuadros 6 y

7 se muestran los haplotipos obtenidos para las muestras evaluadas.

19



Cuadro 6. Haplotipos para muestras de hisopado bucal tomadas en diferentes afios (extraccion por

Chelex).
Toma
Muestra de HV1 HV2
muestra (16024-16365) (73-340)
(afio)
1 2009 Sin amplificacion” Sin amplificacion
2 2009 16,093C 16,129A 16,223T 16,298C  73G 214G 249- 263G 290- 291-
16,325C 16,327T 309.1C 315.1C
3 2011 16,111T 16,223T 16,290T 16,319A 73G 146C 153G 235G 263G
309.1C 315.1C
4 2011 Sin amplificacion Sin amplificacion
5 2014 16,111T 16,223T 16,290T 16,299G 73G 146C 153G 235G 263G
16,319A 16,362C 315.1C
6 2014 16,111T 16,223T 16,290T 16,319A 73G 146C 152C 153G 200G
16,362C 235G 263G 309.1C 315.1C
7 2017 16,111T 16,223T 16,290T 16,319A 73G 146C 152C 153G 214G
16,362C 235G 263G 309.1C 315.1C
8 2017 16,111T 16,290T 16,319A 16,362C 73G 146C 153G 235G 263G
309.1C 315.1C
2012 73G 146C 153G 182T 184G
9 2018 16,223T 16,290T 16,319A 16,362C 235G 263G 309.1C 315.1C

La muestra 9 corresponde a un mismo donante, se evaluo precision y exactitud al obtener el
haplotipo en diferentes afios de toma de muestra. *Sin amplificacion significa que no se logro

obtener banda al evaluar los productos de PCR en Gel.

Cuadro 7. Haplotipo para muestras de diferente sustrato de un mismo donante (extraccion por

QIAamp).
Muestr N n HV1 HV2 Frecuenci
a (16024-16365) (73-340) a
(%)
A 3 2% 16,233T 16,290T 16,319A 73G 146C 153G 182T 184A 100
16,362C 235G 263G 309.1C 315.1C
B 3 3 16,104T 16,111T 16,223T 73G 146C 153G 235G 263G 100
16,290T 16,311C 16,319A 309.1C 309.2C 315.1C
16,362C
C 3 3 16,223T 16,290T 16,319A 73G 146C 153G 235G 263G 100
16,362C 315.1C

*No se logré obtener haplotipo para la muestra de sangre, debido a que la cuantificacion fallo.

Se usaron muestras Oseas que presentaran una concentracion cercana a la deseada a evaluar

(entre 0.002 a 0.300 ng/uL) y con previa evaluacion de STR (datos de la FAFG) para detectar
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indicios de correlacion de esos dos factores en la obtencion de haplotipos reportables, los resultados

se muestran en el Cuadro 8.

Cuadro 8. Haplotipos para extractos 6seas con diferente cuantificacion y perfil genético

reportado.
Muestra Perfil Concentracion HVI HVII
STR (ng/pL) (16024-16365) (73-340)
1h 18 loci 0.298 No se logro amplificar”  73G 263G 309.1C 309.2C
315.1C
2h Completo 0.130 No se logré amplificar ~ 73G 263G 309.1C 309.2C
315.1C
3h Completo 0.050 No se logré amplificar 73G 146C 153G 235G
263G 309.1C 315.1C
4h Completo 0.025 16,111T 16,223T No se logré amplificar
16,290T 16,319A
16,360T 16,362C
Sh Fallo 0.013 No se logré amplificar No se logré amplificar
6h Fallo 0.002 No se logré amplificar 73G 204C 263G 315.1C

“No se logré amplificar” significa que los fragmentos no cubrieron por completo la region, no se

obtuvo secuencia o faltd cubrir la region con alguno de los dos fragmento (sentido o antisentido).

Se evaluaron diferentes diluciones para una muestra esquelética con una alta concentracion de
ADN. Las concentraciones fueron 4.000, 1.000, 0.500, 0.100, 0.050, 0.025 y 0.005 ng/pL. No se
logré amplificar con concentraciones de 0.100, 0.050, 0.025 ni 0.005 ng/pL como se evidencia en
la Figura 5. La frecuencia del haplotipo es del 29 % (N = 7, Cuadro 11, Anexo C) para las
concentraciones de 1.000 y 0.500 ng/uL.
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Figura 5. Gel de agarosa 1% correspondiente a la region HVI para diferentes diluciones de una
muestra Osea.

El primer carril corresponde a la escalera, los carriles numerados con 1,2, 3,4,5,6y 7
corresponden a la muestra evaluada a la concentracion de 4.000, 1.000, 0.500, 0.100, 0.050, 0.025
y 0.005 ng/puL, respectivamente. Los carriles 8 y 9 corresponden al control positivo y negativo,

respectivamente. Todos los productos de PCR son de fragmento lider de la region HVI.

Adicionalmente se evalu6 la sensibilidad para diferentes diametros de perforaciones en FTA
con hisopado bucal. Las perforaciones de 0.5 mm de didmetro con lavados produjeron haplotipos
reportables. Los diametros de 1.2 y 2.0 mm con lavado solamente produjeron haplotipos reportables
para el 50 % de los procesamientos (se trabajo en duplicado). Las perforaciones sin lavados no

proporcionaron haplotipo reportable para ninguno de los tres diametros antes descritos.

D. ESTABILIDAD

Se evaluo la estabilidad de muestras referenciales tomadas en diferentes afios (dos muestras por
afio), y determinar si el periodo de almacenaje es un factor por considerar para la genotipificacion.
Se obtuvo haplotipos reportables (Cuadro 6) para todos los afios de toma de muestra (2009, 2011,
2012, 2014, 2017, 2018), exceptuando una de las muestras tomadas en el 2009 y otra del 2011.

E. REPETIBILIDAD
La repetibilidad evaluo extractos de sangre fijada en tarjeta FTA, bucales fijados en tarjeta FTA

y cabello con raiz de un mismo donante. Este mismo muestreo se hizo para 3 donantes diferentes

22



(A, By O), para los cuales se logré obtener haplotipos reportables (Cuadro 7) con frecuencia del
100%. La cuantificacion fallo para la muestra de sangre del donante A y tampoco se logréd obtener

el haplotipo.

F. REPRODUCIBILIDAD

En la reproducibilidad se evalud si cualquier analista entrenado podria generar haplotipos
reportables, por lo que el Analista 2 reprocesd el control positivo (CEPH) y dos muestras
previamente procesadas por el Analista 1. Los resultados entre analistas tuvieron una frecuencia de

100% de coincidencia (Cuadro 11, Anexo C).

G. CONTAMINACION

Se prepar6 una mezcla de sangre de los donantes A y B. Se observo que en las posiciones en las
que diferian entre los donantes (16104, 16111, 16311, 182, 309.1, 309.2 y 315.1) no se lograron

resolver las ambigiliedades identificadas por Sequencher (Cuadro 9).
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Cuadro 9. Haplotipo para mezcla de muestras.

Referencia  Muestra  Muestra  Mezcladeay
a b b
16,10 C C T N
4
16,11 C C T N
1
16,22 C T T T
3
16,29 C T T T
0
16,31 T T C
1
16,31 G A
9
16,36
2
73
146
153
182
184
235
263
309.1
309.2 : :
315.1 C C
*Sequencher utiliza “N” seglin la nomenclatura UPAC para sefializar ambigiiedades. Estas

3k

-3 3
@
a »
Qo zzocoa o o »  Z

HelaNak i NoNeN»
oocoaacaanana

posiciones no lograron resolverse por el analista.

En la Figura 6 se muestra el pico caracteristico para mezcla de muestras que podria ser util para
la identificacion de contaminacion. Estos picos estan caracterizados por estar sobrepuesto y que

alcanzan una altura similar.
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Figura 6. Picos caracteristicos de un electroferograma en caso de mezclas.
A. Lecturas incongruentes debido a que las muestras difieren por cambio de base. En el
electroferograma inferior se observa picos sobrepuestos y la disminucion de ambas sefiales. B.

Lecturas incongruentes debido que las muestras difieren por inserciones.
H. ESTUDIO POBLACIONAL

La menor capacidad de discriminacion poblacional es corresponde al grupo etnolingiistico achi
con 82.35 %, seguido por queqchi con 87.50 %, quiché con 92.86 %, mestizo, ixil y kaqchikel con
100 % (Cuadro 10). La probabilidad de que dos muestras aleatorias de la poblacion posean
genotipos de ADNmt idéntico corresponden a la Probabilidad de coincidencia aleatoria;
considerando todos estos grupos la Probabilidad de coincidencia aleatoria corresponde a un 1.3 %.
Con una diversidad de haplotipos total del 99.8%; siendo el mas bajo con 97.8 % para el grupo achi
y el mas alto con 100 % para mestizos, ixiles y kaqchikeles. Se obtuvo un rendimiento (R) del 90

% para muestras referenciales.
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Cuadro 10. Parametros forenses e indices de diversidad de secuencias de las regiones HVI y II de
ADNmt para grupos etnolingiiisticos guatemaltecos.

uich
Poblacién Mestizo Ixil Achi  Kaqchikel Queqchi © é General
No. de muestras 17 17 17 15 16 14 97
No. de haplotipos 17 17 14 15 14 13 88
No. de sitios
polimorficos 73 52 41 47 49 32 128
CD (%) 100 100 82.35 100 87.50 92.86 90.72
PCA (%) 5.9 5.9 8.0 6.7 7.8 8.2 1.3
DH (%) 100 100 97.8 100 98.3 98.9 99.8

CD es la Capacidad de discriminacion; PCA, probabilidad de coincidencia aleatoria; DH,

Diversidad de haplotipos.
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VIL ANALISIS DE RESULTADOS

La coincidencia en un 100% del haplotipo esperado y el obtenido para las muestras M2 y M3
reflejan que el protocolo propuesto y las condiciones del laboratorio son apropiados para obtener
secuencias exactas. De igual manera la coincidencia de los haplotipos generados para diferentes

procesamientos de una muestra evidencia la precision del método.

Los resultados del estudio de sensibilidad evidenciaron que el rango ideal para las
concentraciones de ADN es entre 0.015 a 1.780 ng/uL, el cual estd por debajo del 4.0 ng/uL,
recomendado por los fabricantes del kit BigDye™ Direct Cycle Sequencing (Applied Biosystems,
2011). Los resultados de los Cuadros 6 y 7 evidenciaron que los métodos de extraccion Chelex y
QIAamp no afecta la sensibilidad del método ya que se lograron genotipificar las muestras de

ambos métodos de extraccion.

Es posible que el valor recomendado no estd dentro del rango ideal debido a que la
cuantificacion es especifica para ADNn humano y no para ADNmt (Thermo Fisher Scientific,
2018). Debido a que el ADN en exceso puede actuar como inhibidor de la PCR (Alaeddini, 2012),

la reaccion requiere bajas concentraciones de ADNn.

Los resultados de sensibilidad para las tarjetas FTA evidenciaron que el uso de las perforaciones
de 0.5, 1.2 y 2.0 mm de diametro directo en la reaccion de PCR no permite la obtencion de
haplotipos reportables. Aun qué las perforaciones de 1.2 y 2.0 mm con tratamientos de lavado
permitio obtener resultados reportables, el rendimiento fue bajo (50%). Debido a que se desconoce
la cantidad de ADN fijado en las perforaciones no se puede atribuir con certeza como fuente de
error la inhibicién por exceso de ADN. La viabilidad de las perforaciones con lavados puede
contribuirse a que este proceso extra elimina inhibidores de la PCR, sin embargo, el tratamiento no

es suficiente como lo evidencia el rendimiento.

Los extractos de ADN de muestras Oseas revelaron que el rango ideal es de 0.5 a 1.0 ng/uL. El
rango esté por debajo del valor recomendado por el fabricante del kit. Este rango bajo es util debido
a que las muestras 6seas tienden a obtener extractos de ADN con baja cantidad de ADN. Es posible
que el rango se vea disminuido en comparacion al de las muestras referenciales debido a la baja
cantidad y la degradacion del ADNn, asi como de los inhibidores de PCR presentes. El acidos
himicos y fulvicos, residuos de parafirina, otros productos de degradacion y principalmente el
calcio son posibles inhibidores (Alaeddini, 2012; Montiel et al., 1997; Pddbo, 1989). Los resultados
de las muestras del Cuadro 6 evidencian que los perfiles de STR completos no garantizan una a

genotipificacion de ADNmt reportable, cuando las muestras presentan concentraciones inferiores
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al rango ideal para muestras oseas. Esto respalda que los resultados para muestras dseas son
variables debido a su naturaleza, las diferentes condiciones de deposicion y degradacion. La
congruencia entre los resultados en los geles de agarosa y los resultados de secuenciacion,
evidencian que este paso es critico para decidir si se continia con el procesamiento o volver a
reprocesar. En este paso en el caso de obtener una banda se debe continuar con el procedimiento;
en el caso de ausencia de banda, se debe de regresar al proceso de extraccion. Esta decision evitara
la perdida de recursos y tiempo con extractos y productos de PCR que seguramente no se lograrian

secuenciar.

Los resultados de los hisopados bucales tomados desde el 2009 al 2018, mostraron resultados
satisfactorios. Las muestras previas al 2009 pueden procesarse, pero considerando la posibilidad
de que no se pueda genotipificar con éxito o que requieran mas de un procesamiento. Uno de los
donantes poseia una muestra tomada en el 2012 y otra en el 2018 (Cuadro 9, Anexo C), esto
permitié garantizar que la exactitud del método no estd afectada por el tiempo ni método de
almacenaje. En este precedente, es posible que los haplotipos fallidos se relacionen con la
degradacion del material genético o la seleccion de la porcion del hisopo tomado en esta ocasion.
No fue posible determinar extender el estudio de estabilidad mas afios atrds por falta de

disponibilidad de muestras tomadas afios previos al 2009.

Los resultados positivos del estudio de repetibilidad y reproducibilidad evidencian que es
posible obtener el mismo haplotipo para la misma muestra por el personal apropiadamente
capacitado, utilizando los equipos, siguiendo los protocolos de operacion estandar y bajo las
condiciones del laboratorio. Lo cual puede contribuirse en parte a que el laboratorio esta acreditado
bajo la norma ISO 17025 que estandariza y mantiene controlados los equipos y condiciones del
laboratorio. Esta evidencia es suficiente para aceptar que un procesamiento sea completado por

varios analistas.

El estudio de contaminacion proveyd de las caracteristicas necesarias para identificar la
presencia de mas de un haplotipo en una muestra, con el fin de conocer y poder identificar eventos
de contaminacion en una muestra. La falta de resolucion de ambigiiedades en el llamado de bases
por parte de los analistas son indicios de contaminacion. En los electroferogramas cuando para una
posicion se presentan resultados incongruentes o se presentan picos traslapados y de altura media

se deben considerar como indicios de contaminacion.

El estudio poblacional evidencié que del total de muestras (N=102) solamente se logro
genotipificar a 97, con un total de 88 haplotipos diferentes. A pesar de las genotipificaciones

fallidas, se cumple con el minimo de 50 muestras para la validacion segin los lineamientos de
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SWGDAM (2016). La capacidad de discriminacion (CD) general es del 90.72 % debido a que 6
individuos comparten haplotipos, pero para los grupos la CD minima es del 82.35 % y maxima del
100%. Los haplotipos compartidos entre los grupos concuerda con la cercania geografica que
poseen entre si (Pepkin, 2019). La probabilidad de coincidencia aleatoria mas alta corresponde al
grupo quiché con 8.2 % y minima para la general del 1.3 %. Se evidencio que el grupo achi es el
menos diverso (97.8%) en comparacion a los otros, lo cual se respalda con un haplotipo compartido

por tres individuos.

El procesar 102 muestras para el estudio poblacional permite conocer la diversidad genética
para el ADNmt de los guatemaltecos. Los datos son utiles para la formacion de base de datos
poblacional y asi determinar la frecuencia de los haplotipos, lo cual es un indicador de inico o
comun que puede ser la informacion genética de una muestra. Los haplotipos tnicos son preferentes
ya que tienen menor probabilidad de ser atribuidos a un individuo al azar. La combinacion de
resultados estadisticos de los analisis de STR autoséomicos junto con los de ADNmt aportarian a

alcanzar el umbral (segun las politicas de la FAFG) de identificacion humana.

La probabilidad de coincidencia aleatoria es inversamente proporcional a la capacidad de
discriminacion. Un valor bajo para la probabilidad de coincidencia aleatoria es un indicador de lo
unico o poco frecuente que es un haplotipo dentro de un grupo lo cual refuerza la identificacion de
un individuo (la coincidencia con un individuo al azar con la misma informacion genética es
minima). Las poblaciones con menor probabilidad de coincidencia aleatoria fueron la mestiza y la
ixil, seglin el parametro de capacidad de discriminacion. Lo cual significa que los grupos restantes

presentan mayor probabilidad de reportar una coincidencia por eventos de azar.

Se identificaron coincidencias de haplotipos, lo cual puede indicar que el grupo etnolingiiistico
posee baja diversidad genética. Los factores geograficos y lingiiisticos pueden limitar a los
individuos a relacionarse entre si. Lo anterior podria explicar la redundancia entre haplotipos en un
mismo grupo a pesar de que se seleccionaron individuos que aparentemente no estan relacionados
(lo cual fue verificado con genogramas indicados por los donadores). Los genogramas presentan
las siguientes limitantes: pueden contener informacion solamente del nucleo familiar, por lo que no
se podria detectar el linaje materno por parte de abuelas u otras descendientes; debido a que es

informacion provista por los donantes no se puede asegurar que sea correcta.

Las muestras de la validacion y las del estudio poblacional no presentaron un patrén en cuanto
a los fallos de genotipificacion. Debido a que los controles obtuvieron los resultados esperados se
considera como paso critico la amplificacion de PCR. Es posible que existan problemas de

hibridacion entre la muestra y los cebadores, causado por polimorfismos de un solo nucleétido. En
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contraste con el diseflo de este estudio, cuando se realiza la amplificacion de la region control de
ADNmt se utilizan mas de cuatro cebadores, tratando que los fragmentos en un mismo sentido se

traslapen y garantizar una cobertura completa en ambos sentidos (Eduardoff et al., 2017).
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VIII. CONCLUSIONES

El método utilizando los kits BigDye™ Direct Cycle Sequencing y BigDye™ XTerminator
Purification es exacto y preciso, respaldado par la comparacion con laboratorios externos para las

muestras M2 y M3.

El rango ideal de concentracion de ADNn es de 0.015 a 1.780 ng/uL y 0.500 a 1.000 ng/uL para
muestras referenciales y Oseas, respectivamente, para la genotipificacion de ADNmt utilizando los
kits BigDye™ Direct Cycle Sequencing y BigDye™ XTerminator Purification. Las muestras
oseas, incluso dentro del rango ideal, puede no obtener haplotipos reportables debido a eventos de

degradacion.

La estabilidad del método esta limitada para hisopados bucales tomados a partir del afio 2014.
Las muestras tomadas previas al 2014 pueden requerir de mas de un procesamiento para garantizar
un haplotipo reportable, debido a que las muestras pierden su estabilidad ante tantos afios de

almacenamiento.

La repetitividad de la técnica estd garantizada al presentar precision y exactitud al procesar
diferentes muestras (hisopado bucal, sangre fijada en tarjeta FTA y raiz de cabello) de un mismo

donador y obtener el mismo haplotipo de ADNmt en todos los procesamientos.

La reproducibilidad de la técnica da lugar a que cualquier analista con la capacitacion y los
protocolos DNA0070 y DNAOO71 lograra genotipificar el ADNmt con exactitud y precision. El

procesamiento puede ser completado por mas de un analista.

Las muestras contaminadas (mezcla) se caracterizan por ambigiiedades no resueltas debido a la
falta de resolucion del llamado de bases por electroferogramas inconsistentes. Las mezclas pueden

respaldarse al compararse contra un banco de haplotipos.

El método de genotipificacion de ADNmt con los kits BigDye™ Direct Cycle Sequencing y
BigDye™ XTerminator Purification fue exitosamente validado segin las recomendaciones de
SWGDAM. Esta limitado a muestras de hisopados bucales, a extractos de tarjetas FTA fijadas con

saliva o sangre, cabello con raiz, extractos de ADN piezas dentales y partes Oseas.

El estudio poblacional que incluye a los grupos etnolingiiisticos mestizos, ixiles, achies,
kaqchikeles, queqchies y quichés, representa la primera publicacion de haplotipos ADNmt de estas

poblaciones realizada en Guatemala.
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IX. RECOMENDACIONES

. Se recomienda  utilizar el kit Absolute Human Mitochondrial DNA Copy Number
Quantification qPCR Assay (ScienCell Research Laboratories, 2019) para la cuantificacion de
ADNmt de las extracciones. Los resultados permitiran obtener el rango de sensibilidad
verdadero del método, en contraste al establecido en este estudio corresponde a ADNn. En
cuanto a las muestras 6seas y de cabello de raiz, los resultados de una cuantificacion de
ADNmt serian un parametro apropiada para decidir si se requiere concentrar las muestras
previo a su procesamiento para la genotipificacion de ADNmt.

. Eluso de tarjetas FTA con y sin lavados no se recomienda para la genotipificacion de ADNmt.
En el caso de que las muestras estén fijadas en FTA se recomienda realizar una extraccion de
ADN de la tarjeta. Otra opcion es tratar las perforaciones de 1.2 o 2.0 mm con lavados y
procesar las muestras en duplicado.

. Al trabajar con muestras 0seas se recomienda concentrar los extractos si se encuentran por
debajo del rango ideal (0.500 a 1.000 ng/pL), ademas de verificar siempre en gel de agarosa
la amplificacion de los fragmentos.

. Se recomienda validar otros cebadores que amplifique 200 o menos pares de bases en
diferentes posiciones de los fragmentos, en caso de que no se logre secuenciar alguno de los
fragmentos para muestras referenciales o para muestras 6seas degradadas.

. Los hisopados bucales del 2011 y anteriores se recomienda procesar en duplicado y verificar
los productos de PCR en gel de agarosa para obtener un parametro de decision sobre proseguir
0 no con el procesamiento.

. Se recomienda genotipificar el ADNmt de los trabajadores del laboratorio y del personal que
se considere necesario. Adicionalmente se recomienda comparar todas las muestras que
presenten indicios de contaminacion contra todos los haplotipos reportados para descartar o
identificar la fuente de contaminacion. Se requiere de un estudio para validar muestras con
heteroplasmia, utilizando muestras provistas por otros laboratorios con el método de
genotipificacion de ADNmt validados.

. Se recomienda aumentar el nimero de individuos considerados para el estudio poblacional, ya
que otros estudios muestran un minimo de 16 individuos por grupo (Aziz, Nawaz, Afridi, &

Khan, 2019), aunque se han realizado estudios con 99 individuos por grupo poblacional
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(Rakha et al., 2017). Una alternativa es aumentar el nimero de grupos y evaluar la mejor
alternativa para trabajar la informacion poblacional, como grupos etnolingiiisticas o como un

solo grupo.
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Mitochondrial DNA Sequencing using BigDye® Direct Cycle Sequencing Kit
and BigDye® XTerminator™Purification Kit
Standard Operating Procedure

1.0 PRINCIPLE

This protocol describes all steps required to sequence human mtDNA for identification
purposes. This SOP includes PCR amplification, cycle sequencing and post-PCR clean-up
procedures using the BigDye®Direct Cycle Sequencing Kit and BigDye®XTerminator™
Purification Kit.

2.0  BACKGROUND

Analysis of mitochondrial DNA in forensic applications has enabled the identification of
missing persons through comparison with additional maternal relatives. Most forensic
applications are based on sequencing both hypervariable regions of the mtDNA (HVI and HVII).
Sequencing of these regions has been commonly done using Sanger-type sequencing (STS), this
method is based on the use of dideoxynucleotides (ddNTPs) as inhibitors of the DNA polymerase
activity during chain clongation due to the absence of a 3~ hydroxyl group [9.1]. Currently
fluorescently labeled terminating nucleotides are used allowing the detection of the different
sequencing fragments by capillary electrophoresis (CE) [9.2]. At the end, an mtDNA haplotype is
reported for cach sample processed using an analysis software. In a forensic context, haplotype
specific polymorphisms are the basis for identification and comparison between evidence and
reference samples purposes.

The BigDye®Direct Cycle Sequencing kit provides the required reagents for the
sequencing reaction of DNA. This kit is based on fluorescence-based cycle sequencing reaction
to be detected using a Genetic Analyzer through CE [manual del kit]. By using universal
sequencing primers, this kit is versatile to different sequencing purposes, including obtaiming the
sequence of HVI and HVII of mtDNA (see Appendix A for specific primer sequence). This kit
combines PCR purification and cycle sequencing steps in the same reaction plate, enabling a
streamlined and time-saving protocol.

The BigDye®XTerminator™ Purification Kit enables the elimination of unincorporated
dye-labeled components that can interfere with electrokinetic injection, electrophoretic separation
and data analysis. Components of this kit are compatible with BigDye®Direct Cycle Sequencing
kit allowing the elimination of salt ions, unincorporated dye terminators and dNTPs, generating a
high signal strength,

FAFG's validation studics demonstrated that PCR amplification and a good quality
sequence is obtained with a genomic DNA concentration ranging from 0.015 - 1.78 ng/uL. (DNA
mput of 0.015 ~ 1.78 ng). Nevertheless, the kit reccommends a DNA concentration of 4.0 ng/pL;
DNAGOT0_miDNA_SOP
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mtemnal validation showed to generate good quality results with this DNA concentration as well.
The reagents are designed and optimized to be used with the following Applied Biosystems
mstruments: Veriti® 96-Well Thermal Cycler and 3500 Genetic Analyzer.

3.0 SCOPE

This SOP applies for the PCR amplification and cycle sequence of Hypervariable
Regions | and Il from the mtDNA in DNA extracts from reference (buccal and blood samples
extracted by Chelex and QIAGEN methods) and skeletal remains samples for identification
purposes.

4.0 POLICY

This SOP was created to comply with the COGUANOR NTGASOAEC 17025
accreditation, in order to sequence mtDNA correctly.

50  REAGENTS, SUPPLIES & EQUIPMENT

5.1, Kits:
e  BigDye®Direct Cycle Sequencing Kit includes
o BigDye® Direct PCR Master Mix
BigDye® Direct Sequencing Master Mix
BigDye® Direct M13 Fwd Primer
BigDye® Direct M13 Rev Primer
Control DNA CEPH 1347-02, 20-pL, 50-ng/pLL

OO0OO0OO

NOTE: All components, except BigDye® Direct PCR Master Mix should be stored
at-15to <25 °C. BigDye® Direct PCR Master Mix should be stored at -20 °C
until first use, then 4°C. For optimal performance, freeze and thaw the
BigDye® Direct Sequencing Master Mix no more than 5 times.

e  BigDye®XTerminator™ Purification Kit includes
o SAM™ Solution
o  XTermmator® Solution

NOTE: The XTerminator® Solution should be stored at 4°C. Avoid freezing the
reagents. If the work time last more than 30 minutes, keep them on ice with
the caps closed between pipetting steps. The SAM™ Solution should be
stored at 4°C. Storage at room temperature may decrease the likelihood of
precipitation,

5.2. Reagents
e Specific primers for the amplification of HVI and HVII (see Appendix A)

DNAGOTO_nmtDNA_SOP
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E-Gel® EX (1% Agarose Gels)

E-Gel® 1 Kb Plus DNA Ladder

Deionized water

TE (10 mM Tris-HCL 0.1 mM EDTA, pH 8.0)
Bleach, 10% commercial

5.3. Equipment

Micro or mini centrifuge

Plate centrifuge

Vortex

Venti® 96-Well Thermal Cycler
E-Gel®iBase™

3500 Genetic Analyzers

Freezer (at least <17 «C)
Refrigerator (2 - 6 «C)

Pipettes (as needed)

5.4. Supplics.

6.0

o Calculator

e Sterile microcentrifuge tubes, 1.5-mL, or 2.0-mL, or other appropriate clean, unused
tube (for Master Mix preparation)

o 96-well reaction plate for PCR

o 96-well base

o 96-well full plate cover (or reasonable substitute)

Gloves, disposable

Marker pen, permanent

Microcentrifuge tube rack

Tips, acrosol-resistant

Waste container(s )

Laboratory Coat

Safety Glasses

SAFETY

6.1, Treat all biological samples as potentially infectious, Protective gloves, lab coats must be

worn at all times when working of biological samples; the use of any other protective
equipment, such as glasses, is optional. Frequent changing of gloves and/or re-bleaching of
gloves throughout the procedure can reduce the occurrence of random and cross-
contamination.

6.2. All work surfaces, utensils, and instruments used must be cleaned as necessary with 10%

bleach.

6.3. All appropriate MSDS must be read PRIOR to beginning this procedure.,
6.4. The head block of the thermal cycler can become hot during use. Be careful not to touch the

heat block when working with the thermal cycler.
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7.0 QUALITY ASSURANCE

7.1. Always change pipette tips between liquid transfers. Use only aerosol-barrier pipet tips.

7.2. All samples must be appropriately labeled at all times.

7.3. At leastone (1) PCR positive control (sample of known DNA profile and that is non-
probative) must be run with each amplification reaction, It is recommended that two (2)
positive controls be run per reaction should one of the controls fail. FAFG's requires that at
least one (1) positive control amplify correctly per PCR reaction,

74. At leastone (1) PCR negative control (sterile, deionized water or TE) must be run with each
amplification reaction.

7.5. Refer to a supervisor or technical lead for questions regarding this procedure.

7.6.  Ensure that all appropriate worksheets are completed throughout the procedure. This
includes sample processing worksheet, reagent and equipment logs.

8.0 PROCEDURE

%1, PCR lification using BigDye®Direct Cycle § ing Kit:

NOTE: Before using this kit make sure your PCR primers meet the
design requirement: all specific primers must include the M13
universal primer sequences (see Appendix A) at the 5'end.

8.1.1. Determine the total number of samples, including controls.
8.1.2. Thaw and vortex the following reagent for 5 sec:
8.1.2.1. Samples (genomic DNA),
8.1.2.2. M13-tailed forward and reverse PCR primer set for cach
hypervariable region,
8.1.2.3. BigDye® Direct PCR Master Mix
8.1.2.4. Control DNA CEPH 1347-02; 20-pL; 50-ng/pL. Dilute to 4-
ng/pL before use.

NOTE: All components, except BigDye® Direct PCR Master Mix, should be
stored at 15 to <25 °C. BigDye® Direct PCR Master Mix should be stored
at <20 °C until first use, then 4°C. For optimal performance, freeze and
thaw the BigDye® Direct Sequencing Master Mix no more than 5 times.

NOTE: Control DNA CEPH must be diluted to 4.0 ng/pL.

NOTE: M1 3-tailed PCR primers must be prepared at a concentration of 0.8 pM.

8.1.3. Spin the tubes briefly in a microcentrifuge to remove any liquid from
the caps.
4. Sclect a clean, unused tube for the master mix.
5. Prepare 2 reactions (one “reverse” and one “forward") for each sample.
For EACH forward or reverse reaction, prepare your master mix by
adding the following components for cach sample/control:
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Component Volume if Gel Volume if Gel

WONT be run WILL be run
BigDye® Direct PCR Master Mix 5.00 uLL 7.50 uL
Deionized water 250 pul 3.60 plL
M1 3-tailed Reverse primer (0.8 pM) 0.75 plL 1.20 pL
M1 3 -tailed Forward primer (0.8 yM) 0.75 ul 1.20 ul
Total volume: 9.00 L. 13.50 pL.

NOTE: The FAFG worksheets automatically include an extra sample to
account for handling varation. The analyst may change this
value as needed.

NOTE: Before preparing the master mix for amplification, consider that
you must run a gel if a DNA extract was not quantified and/or
for quantified samples with a DNA concentration below the
optimal range (0.015 ng/pL).

8.1.6. Vortex the master mix at medium speed for 5 sec and quick-spin to
remove liquid from the cap.

R.1.7. Dispense 9.00 pL (or 13.50 pL if a gel will be run) of master mix per
well for reaction,

8.1.8. Dispense 1.00 pL (or 1.50 pL if a gel will be run) of mtDNA (0.015 -
1.78 ng/pL) to the appropriate well tube.

NOTE: The final volume in cach PCR tube is 10 pL if a gel won't be
run.
NOTE: The fnal volume in cach PCR tube is 15 pL if a gel will be run.

8.1.9. Prepare a negative control by dispense 1.00 pL (or 1.50 pL if a gel will
be run) deionized water or TE buffer instead of genomic DNA.,

8.1.10. Prepare a positive control by dispense 1.00 pL (or 1.50 pL if a gel will
be run) of Control DNA CEPH 1347-02 instead of genomic DNA.
Recommended concentration 4.0 ng/pL (dilute stock concentration of
50.0 ng/pL accordingly).

8.1.11. Scal the plate with adhesive film or caps and then spin the briefly.

8.1.12. Place the tray in the thermal cycler.

8.1.13. Close the heated cover.

8.1.14. When prompted, select the program “Big dye direct PCR" and change
the reaction volume to 10 pL or 15 pL, accordingly.

R.1.15, Start the thermal cycler

8.1.16. The PCR amplification conditions arc as following:
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Initial Final .
incubati o Denature Anmncal Extend Extension Fmnal Step
Hold 35 cycles Hold Hold
95 °C 9 °C 62°C 68 °C 72°C 4°C
10 min 3 sec 15 sec 30 sec 2 min o0

NOTE: This is a stopping point, you might store the amplified DNA at
4°C overnight or at =15 °C 1o <25 °C for long-term storage.

8.2. Gel Electrophoresis (Optional):

NOTE: The minimum quantity of PCR product to use for sequencing
according to manufacturer’s recommendation is 20-ng. This can
be checked by running on an agarose gel, if necessary. For
optimized amplification this step can be omitted.

For FAFG, a gel is required if a DNA extract was not quantified
and’or for quantified samples with a DNA concentration below
the optimal range (0.015 ng/uL).

. Prepare the appropriate number of 0.2 mL tubes (depending on the

number of samples to run) with 15.0 pl of water.

. Remove the plate scal and take 5.0 pl of cach amplification reaction

(remember that you have two reactions — one “reverse” and one
“forward"” — for cach sample).

. Add this 5.0 pl of sample to cach 15.0 pl of deionized water/TE

buffer/loading buffer.

. Plug the E-Gel® iBase™ device into an clectrical outlet using the

adapter plug on the base.

. Remove the gel from the package DO NOT remove the comb until you

start loading the samples.

. Insert the gel into the base by sliding it into the two clectrode

connections on the iBase™. Make sure that the two clectrodes on the
right side of the cassette are in contact with the two contacts on the
iBase™. The Invitrogen logo should be located at the bottom of the
base. A steady, red light illuminates on the base if the gel is correctly
inserted.

. Take out the comb and add your sample (20.0 pl of cach sample

prepared in step 8.2.4) into its appropriate well in the gel. Use the gel
map available in the worksheet as reference.

NOTE: Always include a positive and a negative control, to verify that
amplification reagents and equipment worked properly.
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8.2.8. Include at least one Molecular Weight Marker per run: Add 20.0 pl of
the 1 Kb DNA Ladder (10.0 - 12.0 ng/pl).

8.2.9. Use the Up/Down ( A\'V) buttons to sclect program: “RUN E-Gel 0.8-
2.0%".

8.2.10. Place the UV protector (orange cover) and press “Go™ button. Run the
gel for a maximum time of 15 min,

NOTE: You can monitor the run by pressing the red button on the
bottom part of the iBase ™ . Make sure the orange cover is
placed before activating the UV light or that you are wearing
the orange goggles.

8.2.11. Document the results in the worksheet, results will be noted with “+" if
a band is present and “-* if the band is absent. Multiple “+" signs
denote the intensity of the band.

£.3. Cycle Soquencing using BigDye® Direct Cycle Sequencing Kit:

NOTE: You will use M13 forward and reverse primers included in
BigDye® Direct Cycle Sequencing kit. Add M13 reverse primer
for the “reverse” reaction; and MI3 forward primer, for the
“forward" reaction for cach sample.

8.3.1. Calculate the required amount of components as shown in next table:

Component Volume
BigDye® Direct Sequencing Master Mix 2.00 L
One sequencing primer: 1.00 pLL

BigDye® Direct M13 Reverse primer OR
BigDye® Direct M13 Forward primer

Total volume of Master Mix for each reaction: 3.00 ul.

NOTE: The FAFG worksheets automatically include one extra reaction
to account for handling variation. The analyst may change this
value as needed.

8.3.2. Vortex the master mix at medium speed for 5 sec and quick-spin to
remove liquid from the cap.

8.3.3. For cach sequencing reaction, add 3 pL of the sequencing reaction mix
to the appropriate well in the respective forward or reverse reaction
well

8.3.4. Scal the reaction plate with adhesive film or caps, then spin the plate
briefly.
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8.3.5. Place the tray in the thermal cycler.

8.3.6. Close the heated cover.

8.3.7. When prompted, select the program “BigDyeDir CycleSeq” and

change the reaction volume to 13 pl.
8.3.8. Start the thermal cycler.
8.3.9. The PCR amplification conditions are as following:
Initial steps Denature | Anncal | Extend | Final Step

Hold Hold Hold 25 cycles Hold
37°C 80 °C 96 °C 96 °C 50 °C 60 °C 4°C
15 min 2 min 1 min 10 sec 5 sec 75 sec *

NOTE: This is a stopping point, you might store the reaction plate at
4°C overnight or at <15 °C to -25 °C for long-term storage.

'E e . I;'

8.4.1. Spin the reaction plate at 100x g for | minute, then remove the seal.

8.4.2. Vortex the Xterminator® Solution bulk container at maximum speed
for at least 10 seconds, until it is homogencous.

8.4.3. Prepare a premix with SAM™ Solution and XTerminator® Solution in
an appropriately sized tube accordingly to the following volumes:

Component Volume
SAM™ Solution 61.40 pL
XTerminator® Solution 13.60 ul
Total volume of Master Mix for each reaction: 75.00 pL.

NOTE: Make sure there are no particulates in the SAM solution before
pipetting, If there are particulates, heat the SAM Solution to
37°C and mix to resuspend. Cool to room temperature before

sing.

NOTE: Manufacturer recommends to use a wide-bore pipette tips to
dispense XTerminator® Solution, If wide-bore pipette are not
available, 1,000 pL tips can be cut previously.

NOTE: The FAFG worksheets automatically include a 5% overfill to
account for handling vanation. The analyst may change this
value as needed.
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R8.4.4. Vortex the XTerminator® Solution bulk container at maximum speed
for at least 10 seconds, until the solution is homogencus.

84.5. Add 75.0pL of SAM™ /XTerminator® solution premix to cach well.

NOTE: Avoid pipetting from the top of the liquid and vortex the premix
constantly, approximately every 4 wells,

8.4.6. Scal the plate with a septa mat and vortex the reaction plate for 30
minutes at 1800 — 2000 rpm.
8.4.7. Spmn for 2 mmutes at 1000xg.

NOTE: It is reccommended to organize your time to place the plate for
CE afterwards. If this is not possible, store the sample plates
scaled with heat scal film or adhesive film for up to 48 hours at
room temperature (20 to 25°C) or up to 10 days at 4°C or -
20°C.

8.5, Capillary Electrophoresis:

8.5.1. After BigDye XTermmator purification, place the plate in the 3500
instrument

NOTE: Before starting the run make sure the instrument is set to
perform sequencing applications; this includes: spatial and spectral
calibration (for Dye Set Z), POP-7 installation, Instrument protocols,
Assay, Run Module, Mobility and Calibration files specific for
BigDye® Direct Cycle sequencing kit.

o Assay: “FastSeq 36 _POP-7"
e Instrument Protocol: “BDXFast Seq 36_POP7_1"
e Basccalling Protocol: “BDTv3.1_PA_Protocol _POP-7"
e Dye:Z
Instrument Oven Run PreRun Injection
Pr. Temperature: 60 °C_| Voltage: 134 kV | Voltage: 13.4kV | Voltage:  1.5kV
- 2520 | PreR PreR Inject
Properties | Run time: - erun ertun njection
sec_ | Time: 180 sec_ | Time: 180 sec_| Time: 3 sec

8.5.2. In the instrument, AB 3500, start by pre-heating the oven at 60°C on
the "Dashboard” menu.
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8.53. Go to the "Workflow" menu and on the "Define Plate Properties”
option create your plate (you can also import it). Make sure that all
Plate details, such as: "Plate type", "capillary lenght" and "Polymer”
ficlds are filled out as the following screenshot:
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8.5.4. Move forward to the "Assign Plate Contents" option, on this window
create the plate set-up accordingly to the plate set-up in your worksheet
manually or automatically if available a plate converter was used).
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8.5.5. Make sure to sclect the options as shown in the following screenshot:
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8.5.6. Press "Link Plate for Run" and move forward to inject your samples

8.5.7. Once the injection has finished press the option "View Sequencing
Results” and the list of all the samples that were sequenced from that
run will appear as shown in the following screenshot:

- - » .

EXERASERCERECEDERUNERRERYING

8.5.8. Seclect the "Sample File name" for cach sample run (usually 4 files will
be selected = 2 per region + 2 primers) and press the button "View
Trace Reports” from the top options. A report will be generated with
quality information about your samples. Save this report. Do the same
with cach sample from your run:
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8.5.9. Open the File where your raw data is stored and save all the injection
documents on your USB. Proceed to analyze sequencing information
according to the SOP DNA0071_Use of Sequencher_SOP .

9.0 REFERENCES

9.1. Sanger, F., Nicklen, S., & Coulson, A. R. DNA sequencing with chain-
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9.2, Berglund, E. C., Kiialainen, A., & Syviinen, A. C. Next-generation
sequencing technologies and applications for human genetic history and
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9.3. Applied Biosystems, Life Technologies (2011) BigDye® Direct Cycle
Sequencing Kit Protocol. Carlsbad, CA.

9.4, Applied Biosystems, Life Technologies (2007) BigDye® XTerminator™™Kit
Protocol. Foster City, CA.

9.5. Applicd Biosystems, Life Technologies (2014) E-Gel Technical Guide.

9.6. Applied Biosystems, Life Technologies (2010) Applied Biosystems
3500/3500xL Genetic Analizer User Guide. Foster City, CA.
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APPENDIX A: Sequence of primers for PCR Amplification of mtDNA
Primer design requirements:

M13 forward sequence
{imﬂ-w-k forward sequence
>~ I ~ Target seq

N

Target-speciic reverse sequence |
M13 reverse sequence

*  MI13 forward primer sequence: 5 TCTAAAACGACGGCCAGT Y
*  MI13 reverse primer sequence: 5 CAGGAAACAGCTATGACC Y

M13-tailed forward and reverse specific PCR primers

Region | Primer | Name l“(',:'::" Sequence (5°-37)
Forward | F1597% Al EI!!!!EQ!QQ AL AT T ALSC LS £ S T
F15989 N/A TGT AAAACG ACG GOC AGT COC AAA GCT AAGATTCTA AT
HV1 R16391 Bl ﬁ?GGMACA GCT ATG ACC GAG GAT GGT GGT CAA GGG
Reverse RI6S00 NIA C > A AT TOY: GAT
RI6423 N/A E:?GMACAGCTAGTACC](:] GCGGGATATTGA TTT
F30 Cl TGT AAA ACG ACG GOC AG'T'("]I‘ ACG GGA GCTCTC CATGC
Fll NA TGT AAAACG ACG GOC AGTCTATCACCCTAT TAA CCA
) C1C
Forward F109 NA (T'(;l'(l' AAAACG ACG GOC AGTGCA CCC TAT GTCGCAGTA TCT
Fi12 NA TGT AAAACG ACG GOC AGT COC CGC TTC TGG CCA CAG
312 / CAC
F317 N/A TGT AAAACG ACG GOCAGTCTTCTG GCCACAGCA CTT
i ) AAA C
HV2 R408 DI CAGGAAACA GCT ATG ACC CTG TTA AAA GTG CAT ACC
GCCA
R99 NA CAGGAAACA GCT ATG ACCAGCGTCTOG CAATGC TAT
/ CGC
' CAGGAAACA GCT ATG ACC AAT ATT GAA OGT AGG TGC
Reverse RI8O N/A GAT 1
' CAGGAAACA GCT ATG ACOGGG GTTTGG TGG AAATTT TTIT
R306 N/A G
R46 ) CAGGAAACA GCT ATG ACC AGG GGA AAATAATGTGTT
50 N/A AGT
RS99 N/A CAGGAAACA GCT ATG ACC TTG AGG AGG TAAGCTACA TA
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Use of Sequencher Software for the Analysis of mtDNA Data from the ABI
3500

1.0 PRINCIPLE

Sequencher® 5.4.6 DNA Sequence Analysis Software from Gene Codes Corporation is a
software used for sequencing analysis. For FAFG's purposes this software will specifically be
used for mitochondrial DNA (mtDNA) typing. It is required to correctly analyze data that is
generated using the BigDye™ Direct Cycle Sequencing Kit.

20 BACKGROUND

Biological samples are processed in the Forensic Genetics Laboratory (DGF) with the aim
of obtaining a mtDNA haplotype. The DNA is extracted from the samples, quantified, amplified
and the mtDNA fragments are separated, detected and sequenced using the ABI 3500 Genetic
Analyzer. After clectrophoresis, the data collection software stores information from cach sample
mn an .abl file. This allows the analyst to see the mtDNA sequence results and asses the
chromatograms, quality, QV20 value and fragment size.

FAFG has a full Sequencher® 5.4.6 license nstalled in a computer. Client licenses are run
mn a USB key in one computer.

3.0 SCOPE

This procedure applies to all samples that have been amplified in the FAFG's Forensic
Genetics Laboratory for mitochondrial DNA analysis and run on an ABI 3500 Genetic Analyzer.

4.0 pOLICY

All staff in the Forensic Genetics Laboratory working under 1SO accreditation shall
adhere to the procedure on the use of Sequencher software. The biological samples processed in
the Forensic Genetics Laboratory with the aim of obtaining a mtDNA haplotype need to be
analyzed and interpreted using the Sequencher® 5.4.6.

5.0  SUPPLIES & EQUIPMENT

e Sequencher® 54.6
e Windows Systems PC Platform Computer

NOTE: Make sure that your computer meets the following mmimum
recommended requirements: Windows 8 or later, 64-bits only, 3 GB
RAM, 280 MB hard disk space.

6.0  SAFETY

DNAOOT1_Use of Sequencher SOP
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Prolonged computer analysis may cause muscle soreness, eye fatigue, or other
discomforts. In order to minimize the occurrence of discomforts, periodic breaks from computer
analysis are encouraged.

7.0 QUALITY ASSURANCE

7.1. Ensure all worksheets are complete.

7.2. Ensure that the negative control fragments are less than or equal to 5 bp size.

7.3. Make sure that the positive control, CEPH from the Big Dye Direct kit,
fragments are more than or equal to 404 bp length for HVI and 414 bp for
HVII, a minimum of 50% of quality, complete comparison range coverage
(these means two fragments [forward and reverse] per region [HVI and
HVII]), compare consensus to reference rCRS (revised Cambridge Reference
Sequence) and selected Consensus to Forensic Standards,

7.4. The positive control fragments MUST generate an haplotype equal to the
reported for Control DNA CEPH (Table 1).

Table 1. Control DNA CEPH haplotype.

Variant
1 16069 C T
2 16126 | T C
16291 € A
3 A G
S 12 | T C
[ 185 | G A
188 | A G
28 | G A
263 | A G
10 25 | C T
113091 | C
12 3ns1 | ¢ C

7.5. For cach sample the comparison range coverage is complete, compare
consensus to reference rCRS and selected Consensus to Forensic Standards
and a minimum quality of 50%.

NOTE: The quality could be less if the complement fragment has a
high quality.

8.0 PROCEDURE

&.1. Open Sequencher and import sample files
8.1.1. Connect the hardware key (USB) before opening Sequencher.

8.1.2. Open Sequencher with double click at the icon M

DNAGOT]_Use of Sequencher SOP
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8.1.3. Seclect File> Save Project, the "Save As" window pop up and save the
project as the batch number (example Sequencher_ddmmyyhhmm).

8.1.4. Import the reference rCRS by select File>New Project From Template
> rCRS. This step can be repeated at is needed for controls and
samples.

8.1.5. Import sample files by select File>Import>Sequences (sclect files .abl
with the controls and samples).

8.2, Compare consensus to references
8.2.1. Select Contig=Consensus for Forensic Standards.
8.2.2. Select with Ctrl+ the rCRS and the fragments related to one sample or
positive control.
8.2.3. Seclect Assemble>Assemble to Reference (Sequencher would align the
fragments). A "Contig" is made in the project window. If the quality is
too low the software would not take a fragment as part of the "Contig".

NOTE: The software would align fragments even if they not
completely cover the region.

NNOTE: You can label the contig by clicking on "Contig" at the
project window, it is recommended to change the name to
FAFG's sample ID.

8.2.4. Double click on "Contig" at the project window will open the Contig
window. Select the “Bases™ option at the options bar. And then the
“Show Chromatograms™ option. Now the sequence and the
chromatograms are available to edit the base calling.

8.3, Policy for editing the base calling
8.3.1. Only edit the base calling at the HVI and HVII regions.
8.3.2. Edit just the base called marked with "+",

NOTE: The "+" symbol under the consensus line flags an ambiguous

position. The """ symbol under the consensus line flags a
position where the base calling is different between the
sample and the rCRS.

8.3.3. Make sure that the ambiguous position can be resolve by one of the
fragments (reverse or forward). If it is not possible identify the
fragment with the lowest quality and process it again.

8.3.4. If the two fragments present an overlap of peaks (Figure 1) in the same
position, this can mean that the sample was contammated or is
heterozygous (event of heteroplasmy). This sample has to be processed
again to discard a contamination event,
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NOTE: ONLY the region with the peaks overlap should be processed
again,

»
AT CC AT EAT AT CReaceracatteantattafMl oARCATACTIACTAMAGTATATTARTTARI TARTACTTRIAROAL
e »

AT CCT ORI TATCOCACCTACORRCANTATEARNI] SARCATACTTACTAMASESROTTARET AMERAATSET 1/

JECATCETATTATIIATCRCACCTATATICAATATY JOAMCATACTIACTAMASTATATTARTTARTTAATACTT AT AN,
. .

.................................. sesssssnnssssnssecs@ecccssncsssnnss

or
B4 A4
. e Y

[V §
v
A

Figure 1. Peaks in case of contamination or heterazy gous sample.

K.4. Editing the base calling

84.1.

842

843,

844

Check, from the "Edit" menu, that the "Replace When Editing" is
sclected.

NOTE: This option will just "Replace When Editing" so if an insertion
is needed go to the "Edit" menu and select the "Insert When
Editing". The insertion would be placed before the selected
position.

Select the base at the Consensus position (this allow to select the base

position in both fragments).

NOTE: From the "Select” menu, choose the command "Next
Ambiguous Basc" or by pressing "CtrlN" so automatically
can move to the next ambiguous position.

Press the letter "A", "C", "T" or "G" to change the base calling when
the problem at the ambiguous position is a base call error or the
software identifies a deletion instead of a base.

NOTE: The ":" at the sequence denots a deletion,

Press "Backspace” to make a deletion at the sequence.

DNAGOT1_Use of Sequencher SOP
Printed copies of this document could be out of date and should be considered uncontrolled.

55



Fundacion de Antropologia Forense de Guatemala
(O vot 1o be copled or distributed without aut borizatios

DNAOOT! Use of Sequencher | Revision:Original | Effective date: 05/03/2019 | Page Sof 6

NOTE: A window will pop up (Figure 2). Select "OK". This option
will just "Replace When Editing" so if an insertion is needed
go to the "Edit" menu and select the "Insert When Editing".

B sequencher =
@ The Undo command is not avaiable for this deletion. Contirue?

s | [k ]

Figure 2, Window in casc of deletion,

&.5. Haplotype report
8.5.1. Retum to the project window and select all the Contigs needed for the
report.

NOTE: Select multiple Contigs by Ctrl+,

8.5.2. Select from the menu Contig=Compare Consensus to Reference.

8.5.3. At the new window select Comparison Range then check that the
"Filter Comparison by:" option is selected, press "Select All" and then
press "OK",

8.5.4. For a report: from the menu select "Reports”, at the "Varnance Table
Reports” window select "Entire Table" option and set the "Report
format" as "Variance Detail Report”,

NOTE: for a simple report select set the "Report format” as "Individual
Variance reports”,

8.5.5. Then Select the "Save as PDF" to export the report as a pdf file. Save
the Report as the batch number (example: Haplotypes #).

9.0 REFERENCES
9.1. Gene Codes Corporation. (2017). Tour Guide for Windows and Macintosh
Tour Guide. Retrieved marzo 2019, 6, from Gene Codes:
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C. ANEXO

Cuadro 11. Haplotipos para diferentes concentraciones de una muestra 0sea.

Muestra N n HV1 HV2 Frecuencia
(16024-16365) (73-340) (%)
7h 7 2 16,111T 16,187T 16,209C 73G 146C 153G 163G 29

16,223T 16,290T 16,319A 309.1C 309.2C 315.1C
16,362C 16,365T
Se evaluaron 7 (N) concentraciones (de 4.0, 1.0, 0.5, 0.1, 0.05, 0.025 y 0.005 ng/uL), para las cuales

solamente 2 (n) presentaron haplotipos reportables (1.0 y 0.5 ng/uL).

Cuadro 12. Haplotipos de muestras procesadas por analistas diferentes.

Muestr n HV1 HV2 Freczenm
a (16024-16365) (73-340) o
CEPH 2 16,069T 16,126C 16,291 A 73G 152C 185A 188G 228A 263G 100

295T 309.1C 315.1C
8 2 16,111T 16,290T 16,319A 73G 146C 153G 235G 263G 309.1C 100

16,362C 315.1C
9 2 16,223T 16,290T 16,319A 73G 146C 153G 182T 184G 235G 100
16,362C 263G 309.1C315.1C

Las muestras fueron procesadas por el Analista 1 en octubre del 2018 y por el Analista 2, en febrero
del 2019.
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